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Lab 1 - Create a Basic HTML5 Layout
In this lab, you will create an HTML5 template which will serve as the starting point for 
creating new HTML files in upcoming labs.

This lab will help you understand what a very simple HTML5 document looks like. 
Specifically, you will learn to declare the DOCTYPE and character encoding.

When creating HTML5 files, you will use Notepad as a text editor.  Of course, you're free
to use another text editor if you'd prefer.

Also, we'll be using Google Chrome as a web browser, since it provides the best support 
for HTML5 in a Windows environment.  

Note:  On the Mac, Safari provides the best support for HTML5.  Feel free to 
experiment with other web browsers, such as Firefox .  However, we can't guarantee that
all the HTML5 pages you create will render properly in those other browsers.  If you 
want to see how well your browser supports HTML5, navigate to 
http://www.html5test.com from within the associated browser.

Note:  These labs were written using Chrome 23.0.x.  If you're using another version of 
Chrome, you may see slight differences in the GUI.

Part 1 - Clear the Browser Cache and Location Settings

In this part, you will clear Chrome's cache and location settings.  This will help ensure 
that any cached files and stored location settings will not interfere with any of the labs.  

__1. Open Chrome.

__2. Click the icon to the right of the location bar and select Settings from the drop-down
menu. Older Chrome versions will show Options instead of Settings.
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__3. Under Settings expand Show advanced settings...

__4. Under Privacy click the Clear browsing data button.

__5. Check all the checkboxes.

__6. Select the beginning of time option from the Obliterate the following items from 
drop-down box.

__7. Click the Clear browsing data button.
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Wait for the clearing process to complete.

__8. Click the Content settings button, which is located to the left of the Clear 
browsing data button.

__9. Scroll down in the browser and click the Manage exceptions button under the 
Location section.

__10. If any exceptions appear in the panel, select the exception and click the X to the 
right of it to delete the exception.
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__11. Click the X in the upper right corner of the Geolocation Exceptions panel to close 
the panel.

__12. Click the X in the upper right corner of the Content Settings panel to close the 
panel. 

__13. Close the browser.

Part 2 - Create the Template

In this part, you will create the HTML5 template.  The template will consist of the 
following elements:

• DOCTYPE 

• html

• head

• meta (used to specify character encoding)

• title

• body 

__1. From Applications open Brackets. Brackets is a text editor that was pre-installed 
for you. You do not need to use anything but a regular text editor for the labs but this 
program has some tools that can make it easier to work with the web pages you will be 
editing. Use the text editor of your preference.

__2. If there is any opened file, close it.

__3. From the menu, select File → New.

__4. Enter the DOCTYPE declaration, followed by the html element:

<!DOCTYPE html>
<html> 

The DOCTYPE declaration must be the very first element in your HTML5 document.  It 
even must appear before the html element.  
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Note:  For those of you who are familiar with XML and XHTML (an XML compliant 
version of HTML), the DOCTYPE element is used to indicate the document type 
definition (DTD) that an XML document adheres to.  A DTD is used to specify the 
grammar of an XML document.  

However, an HTML5 document is not XML, so the DOCTYPE element is not required 
for this purpose.  Instead, it's used to trigger "no-quirks mode" (a.k.a. "standards mode").
"No-quirks mode" implies the browser renders the page according to the HTML5 and 
CSS standards.  "Quirks mode" implies it doesn't and instead tries to maintain backward 
compatibility with legacy pages created for older browser versions. 

Also, notice that in HTML5 the DOCTYPE element is kept very minimal and simply 
includes the root element name.  Normally, when entering a DOCTYPE element in an 
XHTML/XML document, you would need to specify several other pieces of 
information, including a URL pointing to the DTD (see example below).  However, 
since the DOCTYPE element is not being used to reference a DTD, we can omit this 
additional information.  

e.g.,

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

Note:  The DOCTYPE element is case insensitive.  You could have written the 
following instead:

<!DOCTYPE HTML>

<!doctype html>

__5. Define the document's character encoding inside the head element as shown below. 

<head>  
   <meta charset="utf-8"/>  
   <title>HTML 5 Template</title>  
</head>

Note:  The character encoding declaration is shorter than the one you're accustomed to 
writing in HTML4:

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">
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Note:  HTML5 is not XML.  Hence, element names are not case sensitive, elements 
don't require both a start and end tag, and attribute names don't need to be enclosed in 
quotes.  Hence, you could have expressed the meta element in any of the ways listed 
below:

<META CHARSET="utf-8"/>

<META CHARSET=utf-8/>

<meta charset="utf-8">

<meta charset=utf-8/>

<Meta CharSet=Utf-8>

Having said that, we will use XML syntax going forward.

__6. Finally, add the body element and the html close tag to the document:

<body>  
   Contents goes here...
</body>  

</html> 

Next, you will save the HTML file to the Apache Web Server document root. 

__7. Open Windows Explorer.

__8. Open Finder and locate the htdocs folder under your user folder.  If this folder 
doesn't exist then create it. For example Users\YouUserName\htdocs

__9. Create a folder called layout under the htdocs folder.

__10. Save the HTML file in this folder as html5Template.html within the layout folder.

Part 3 - Test

In order to test the HTML5 document, we'll use Google Chrome, since it provides the 
best support for HTML5. 

__1. Open the Chrome browser.

__2. Enter the following URL into the address bar:

http://localhost/layout/html5Template.html 

__3. You should see the following screen:
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__4. Close the all.

Part 4 - Review

In this lab, you created a template for your HTML5 files.  In the process, you learned 
how to declare DOCTYPE and meta elements.
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Lab 2 - Improve Your Forms Using HTML5
An HTML form is used for gathering information from a user and submitting it to a 
server to be processed.  This information normally needs to be validated.  This is 
typically done both on the client side and the server side, since client validation may be 
turned off in the browser.  

Prior to HTML5, the form fields didn't have any built-in validation logic.  That meant 
you were stuck writing JavaScript code to perform client side validation, which was both 
tedious and error prone.  Now in HTML5, new input types were introduced containing 
built-in validation logic, which eliminates the need for JavaScript code (see note below).  
In this lab, you will learn to use several of the new input types:  e-mail, date, number, 
and range.  

In addition to these new input types, HTML5 also supports three major new features for 
form fields:  the placeholder, autofocus, and pattern attributes.  Implementing the 
features provided by these attributes used to require JavaScript code.

The placeholder attribute allows the developer to define the text that will appear in a text
box-based control when its contents are empty.  When the field gains focus, the text is 
removed.  If the user doesn't type a value into the field and the field loses focus, the text 
is restored.   You may want to use the placeholder attribute when implementing a search 
field to indicate to the user they should input a value.  This way, you don't need to define 
a label for the search field that's displayed adjacent to it.   

The autofocus attribute tells a browser to automatically give focus to a particular form 
field when the page is loaded.

The pattern attribute is used to specify a regular expression that a field's value must 
match.

Note:  You'll still want to have JavaScript code inside your pages for older browsers that
don't support HTML5 or for newer browsers that don't fully support HTML5.  You can 
navigate to http://www.html5test.com to see how well your browser supports HTML5.  
Below are the results for Google Chrome v10.0.x., which provides fairly good support 
for the new HTML5 form features:
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Part 1 - Create an Input Form Using the New HTML5 Input Types

In this part, you will create a new HTML file, based on the template, which will contain 
an input form for registering a new employee.  You will make use of several of the new 
input types which provide built-in validation.

__1. Open \layout\html5Template.html. This should be under 
Users\YouUserName\htdocs\ folder. 

__2. Save the file as registerEmployee.html in the same folder.

__3. Change the title content to:

<title>Register an Employee Form</title>

__4. Remove the content inside the body element.

__5. Add the following code inside the body element:

<h1>Employee Registration Form</h1>
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Next we will create the registration form.

__6. Add the following form element:

<form action="thankYou.html">
</form>

__7. Add a label and a corresponding text field for the employee's name inside the form 
element:

<label for="fullName">Full Name:</label><br/>
<input type="text" name="fullName" id="fullName" placeholder="Enter 
your full name" autofocus required />*<br/>

Notice the following:

• We used the placeholder attribute to specify text that will appear inside the field 
when the page is loaded.  This gives the user a visual cue that they need to input 
their name into the text field.

• We used the autofocus attribute to indicate that the field should automatically get 
focus when the page is first loaded.  Before HTML5, this could only be done 
using JavaScript. 

• To specify that the employee's name is mandatory, we used the new HTML5 
attribute  required.    

Note:  When specifying autofocus and required, it's also legal to use XML syntax:

<input type="text" name="fullName" id="fullName" placeholder="Enter your full 
name" autofocus="autofocus" required="required" />

__8. Add a label and an e-mail field for the employee's e-mail:

<label for="email">E-mail:</label><br/>
<input type="email" name="email" id="email" placeholder="Enter a valid 
e-mail" required />*<br/>
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Notice the following:

• To create an e-mail field, we used the input element and specified the new HTML 
input type email.

• To specify that the e-mail is mandatory, we used the new HTML5 attribute 
required.   That means the required attribute is not specific to text fields (input 
type="text"), but can be used with many of the new input types too. 

__9. Add a label and a date field for the employee's date of birth.

<label for="dateOfBirth">Date of Birth:</label><br/>
<input type="date" name="dateOfBirth" id="dateOfBirth" required />*<br/>

Notice the following:

• To create a date field, we used the input element and specified the new HTML 
input type date. 

__10. Add a label and a number field for the employee's age:

<label for="age">Age:</label><br/>
<input type="number" name="age" id="age" size="6" min="18" max="120" 
step="1" value="21" /><br/>

Notice the following:

• To create a number field, we used the input element and specified the new HTML 
input type number.

• We used the size attribute to indicate how many characters (6) can be input for the
employee's age.

• We used the min and max attributes to specify the minimum age (18) and 
maximum age (120), respectively.

• We used the step attribute to specify the interval (1) between valid values (e.g., 
18, 19, 20). 

• We used the value attribute to specify the default age (21).   

__11. Add a label and a range field for the employee's number of years of experience:

<label for="rating">Years of Experience:</label><br/>
<input type="range" name="rating" id="rating" min="0" max="100" 
step="1" value="0" /><br/>
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Notice the following:

• To create a range field, we used the input element and specified the new HTML 
input type range.

• We used the min and max attributes to specify the minimum number of years of 
experience (0) and maximum number of years of experience (100), respectively.

• We used the step attribute to specify the interval (1) between valid values (e.g., 1, 
2, 3). 

• We used the value attribute to specify the default number of years of experience 
(0).  

__12. Add a label and a text field for the employee's phone number:

<label for="phone">Phone:</label><br/>
<input type="text" name="phone" id="phone" pattern="[0-9]{3}-[0-9]{3}-
[0-9]{4}" placeholder="XXX-XXX-XXXX" required />*<br/>

Notice the following:

• To create a phone number field, we used a standard text field.  There is no new 
input type for phone numbers.  

• HTML5 allows us to use regular expressions to limit the set of values that you can
input into a field.  In this case, we input a regular expression which restricts the 
set of values to a number that looks like this:  XXX-XXX-XXXX

• We used the placeholder attribute to display the phone number pattern to the user
so they don't mistype it. 

Note:  The string start ^ and end $ indicators are not required for the regular expression.
This is because HTML5 automatically prefixes the regular expression with ^(?: and 
suffixes it with )$. 

__13. Finally, add a submit button to allow the user to submit the form and a label 
indicating that any fields with an asterisk (*) next to them are required.

<input type="submit" value="Register" />
<p>Fields marked * are required.</p>

__14. Save and close the file.

__15. Copy LabFiles\thankYou.html to \htdocs\layout, since the form submits to that 
page.
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Part 2 - Test

__1. Open Google Chrome.

__2. Navigate to the following URL:

http://localhost/layout/registerEmployee.html

__3. You should see the following screen:

Notice the following:

• The Full Name field has focus thanks to the autofocus attribute.

• The placeholder text appears inside the fields.

__4. Also, notice the following:

• Chrome rendered the E-mail field (input type="email") as a text field.  HTML5 
does not mandate any default user interface for the new input types, so each 
browser and device is free to choose how to render them.
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• Chrome rendered the Date of Birth field (input type="date") as a spin box (i.e., a 
text field with up and down arrows that you click on to change the value) that 
allows you to increment/decrement the date by a day.  Ideally, it would have been 
preferable if it rendered a date picker.  Once again, HTML5 does not specify a 
default rendering for this input type.

• Chrome also rendered the Age field (input type="number") as a spin box.  
However, when you click the up and down arrows, the age is incremented by the 
value of the step attribute (1).

• Chrome rendered the Years of Experience field (input type="range") as a slider 
bar.  However, we can't tell what the value selected is.  We'll address this 
limitation in the next part of the lab.

Note:  If you loaded this page in Opera 11.01, this is how it would look:

Notice the date field is rendered as a drop-down.  If you click on the drop-down, a date 
picker will be displayed:
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Note:  If you load a page in an older browser that doesn't support/fully support HTML5, 
the new input types will be ignored.  The input types will gracefully degrade to text 
fields (type="text").

e.g., Internet Explorer 7
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Now let's test how the form works.  We'll test the "happy day" scenario first.

__5. Input the following values:

Full Name:  Mike Harris

E-mail: mharris@yahoo.com

Date of Birth:  01-23-1980

Age:  21 (default value)

Years of Experience:  0 (default value)

Phone:  215-314-2300

__6. Submit the form by clicking Register.

__7. You should see the thank you page.

Now let's try some error scenarios.  First, we'll see what happens if you omit a required 
field.

Copyright 2016 Web Age Solutions Inc. 18

EVALU
ATIO

N O
NLY



__8. Click the Back button (left arrow).

__9. Delete the text in the full name field.

__10. Try submitting the form.

__11. You should see the following error message:

Pretty cool!

Let's try another error scenario.  Let's see what happens if the user types in an invalid e-
mail address.  

__12. Enter Mike Harris back into the full name field.

__13. Change the e-mail address from mharris@yahoo.com to mharris.

__14. Try submitting the form.

__15. You should see the following error message:

Note:  Opera will also display a visual cue (callout box) indicating a validation rule has 
failed when you try submitting the form, as shown below.  The error messages though 
are a little bit different.  This is because the HTML5 specification doesn't dictate what 
error messages should be displayed.
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Part 3 - Display the Value of the Range Field

In this part, you will add some JavaScript and HTML code to display the value for the 
number of years of experience that the user input, since Chrome doesn't automatically 
display values for range fields.

__1. Open registerEmployee.html.

__2. First off, add a span element to the right of the range field.  The span element will 
display the value the user selected for the number of years of experience:

<input type="range" name="rating" id="rating" min="0" max="100"
step="1" value="0" />
<span id="ratingValue">0</span><br/>

__3. Next, add an onchange event handler to the range field that gets called after the user 
drags the slider to a new position:

<input type="range" name="rating" id="rating" min="0" max="100" 
step="1" value="0" onchange="displayRating(this);" />

Note:  The parameter this that's passed to the displayRating function is a reference to 
the current element (i.e., the input element).

__4. Add a script element before </head>.

<script>
   
</script>

Note:  In HTML5, you no longer need to specify the type attribute to indicate the 
category of scripting language you're using.  It now defaults to "text/javascript".

Copyright 2016 Web Age Solutions Inc. 20

EVALU
ATIO

N O
NLY



__5. Add the event handler function, displayRating, inside the script element:

function displayRating(slider) {
   document.getElementById("ratingValue").innerHTML = slider.value;
}

This function retrieves a reference to the span element and updates the HTML inside with
the slider value. 

Note:  Remember, JavaScript is a case sensitive language so pay attention to case.

__6. Save your changes.

__7. Close all open browsers.

Now let's test the changes.

__8. Navigate to the following URL:

http://localhost/layout/registerEmployee.html

You should now see 0 for the number of years of experience listed to the right of the 
slider. 

__9. Drag the slider all the way to the right. Make sure the value increments in steps of 1 
and reaches a maximum value of 100.   

__10. Now drag the slider all the way to left.  Make sure the value decrements in steps of 
1 and reaches a minimum value of 0.  

Troubleshooting:  If the value doesn't get updated when you drag the slider, refer to the 
next section for troubleshooting instructions.
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Part 4 - Troubleshooting JavaScript Problems in Chrome

In this part, you will learn a little bit about how to troubleshoot JavaScript related 
problems that crop up when using Chrome.  

For example, if you load a web page that has JavaScript syntax errors and do something 
that invokes that code, Chrome won't display any errors unless you open the Developer 
Tools.  Aside from viewing syntax errors, you can use the Developer Tools for debugging
semantic errors.

In our case, we will pretend you made a typo.

__1. Change the code as shown in bold below:

function displayRating(slider) {
   document.getelementById("ratingValue").innerHTML = slider.value;
}

__2. Save the file.

__3. Refresh the browser to pick up the changes.

__4. Try dragging the slider.  

Notice that the value stays at 0.  Let's see why.  

__5. Select Tools->Developer tools from the menu bar.  

__6. The Developer tools should appear in the lower half of the browser window. Click 
the Sources tab and expand the html code.

Notice the red X in the lower right corner of the screen.  This indicates there are errors in 
your page.  
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Note:  You will probably see a different number of errors than above.  The number 9 
does not indicate how many errors there are in the HTML file.  In our case, there is only 
1 error.  It just indicates how many times that line of code was executed in error (in this 
case, 9 times).  Since I kept dragging the slider to the right, it kept trying to execute the 
same line of code to update the value.

__7. Click the Console tab.  

It should show you the error message that occurred when executing the code, along with 
the offending file and line number.

The error message is very clear.  The HTMLDocument object doesn't have a method 
named getelementById.

__8. Click the registerEmployee.html:9 link.

__9. Chrome will show you the offending line of code in the Scripts tab.

__10. Fix the error in the code.  

__11. Save your changes and refresh the page.  

__12. Now try dragging the slider.  The value should be updated and you should see no 
red Xs in the Developer Tools.

Now let's try debugging using the Developer Tools.

__13. Click on the Sources tab inside the Developer Tools panel.

__14. Click inside the gray margin to the left of the document.getElementById() line of 
code inside the displayRating function.
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__15. Verify a breakpoint symbol (blue arrow) appears.

__16. Try dragging the slider.

__17. Verify that the breakpoint was hit.  The line of code should now appear in blue.

Note:  When a breakpoint is hit, it means that the line of code (in our case, 
document.getElementById()) is about to be executed.

__18. In the right panel, look inside the Scope Variables panel and you'll see the slider 
variable listed.  

__19. Expand it and you can see the value of its properties. 

Ordinarily, being able to see the value of a variable or its properties can be useful in 
troubleshooting semantic errors.  In our case, it doesn't help us, since we don't have any 
semantic errors.
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__20. To execute the line of code, click the Step over next function call button in the 
toolbar at the top of the panel.

__21. The cursor should advance to the next line of code.

Note:  There is also a Step into next function call that allows you to step through the 
code inside of a function that's called by the current function. This can be useful in terms
of troubleshooting functions you've written which call other functions. 

__22. Click the Resume script execution button (to the left of the Step over next 
function call button) to resume running the script.

__23. Remove the breakpoint by clicking on the blue arrow in the margin.  The arrow 
should disappear.

__24. Close the Developer Tools by selecting Tools->Developer tools from the menu bar.

Note:  You can also press Ctrl-Shift-I to open and close the Developer Tools.

Part 5 - Display the Value of the Range Field Using the Output 
Element

In this part, you will replace the existing span element and JavaScript function that you 
used to display the slider value with the new output element.  The output element was 
introduced in HTML5 to display the result of a calculation.  
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__1. Replace the span element:

<span id="ratingValue">0</span><br/>

with the output element:

<output name=output>0</output><br/>

__2. Add the 'oninput' attribute below to the 'rating' input element, so that it looks like so:

<input type="range" name="rating" id="rating" min="0" max="100" 
step="1" value="0" oninput="output.value=rating.value"/>

Like the output element, the oninput attribute was also introduced in HTML5.  It's used 
to specify what happens when the oninput event is triggered .  This event is triggered 
when the user interacts with an input control.  In this case, we're setting the  value of the 
output element to the value of the rating element. 

__3. Delete the script element, containing the displayRating function, since it's no longer
needed.

__4. Save your changes.

__5. Refresh the browser.  You should now see 0 for the number of years of experience 
listed to the right of the slider. 

__6. Drag the slider all the way to the right. Make sure the value increments in steps of 1 
and reaches a maximum value of 100.   

__7. Now drag the slider all the way to left.  Make sure the value decrements in steps of 1
and reaches a minimum value of 0.  

Part 6 - Style the Error Fields

In this part, you will create some CSS styles so that fields that fail validation show up in 
pink.  
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__1. Add the following style element before </head>:

<style type="text/css">
   :required, :invalid { background-color: pink; }
   :valid { background-color: white; }
</style>

HTML5 introduced new pseudo-classes that can be used to style validation errors.  In this
case, you specified that any required elements or invalid elements should have a 
background color of pink, whereas any valid elements should have a background color of
white.

__2. Save and close the file.

__3. Refresh the page.

You should see the following screen:

You may see all the background in pink instead, like this:

Notice that all the required fields (Full Name, E-mail, Date of Birth, and Phone) are 
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displayed in pink.  This makes sense, given that they're not filled in.  It also indicates that 
Chrome validates the field data even before you submit the form.

__4. Input Mike Harris for the full name.

Notice the Full Name field turns white.  This means the field is valid.  Remember that 
you set the background color for the :valid pseudo-class to white.

__5. Now input mharris@yahoo.com for the e-mail.  

Now the E-mail field should turn white.

__6. Repeat this process for the remaining fields.

__7. Submit the form.  You should see the thank you page. 

__8. Close the browser.

Part 7 - Review

In this lab, you learned how to:

• Use some of the new input types:  e-mail, date, number, and range

• Use the autofocus, placeholder, and pattern attributes

• Use the output element and oninput attribute.

• Style the fields that are in error
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Lab 3 - Drawing Using the Canvas Element
In this lab, you will learn how to draw 2D graphics using the canvas element introduced 
in HTML5.  The canvas element allows you to draw rectangles, ovals, lines, arcs, text, 
images, etc. We won't be drawing anything too fancy in this lab.  Instead, we'll simply 
draw a green rectangle containing two red diagonal lines.

Part 1 - Create a 2D Drawing Using the Canvas Element

In this part, you will create a new HTML page that uses a canvas element to render the 
image above.

__1. Create a new folder called canvas within the htdocs folder.

__2. Open htdocs\layout\html5Template.html and save it as drawOnCanvas.html in 
the canvas folder.

__3. Change the title content to:

<title>Draw Something</title>

__4. Remove the content inside the body element.

Next we will create our canvas. 

__5. Add a canvas element inside the body element:

<canvas id="c" width="400" height="300">
   Your browser does not support the canvas element.
</canvas>
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A canvas doesn't display anything by default.  It's just used to define a rectangular region 
within the page that you can draw on.  To draw on it, we'll need to use JavaScript.  A 
canvas element has a corresponding DOM element (called HTMLCanvasElement) that 
we can use to draw graphics.  

Note:  Technically, you can have many canvas elements inside your page, each of which
contains it own drawing. 

__6. Add an onload event handler to the body element:

<body onload="drawOnCanvas();">

When the page loads, the drawOnCanvas function, which we'll be writing next, gets 
called.  

__7.  Add the following script element before </head>:

<script>
   
</script>

__8. Add the declaration for the drawOnCanvas function before </script>:

function drawOnCanvas() {

}

__9. Add the following variable declarations inside the drawOnCanvas function:

var c = document.getElementById("c");
var ctx = c.getContext("2d");

The code does the following:

• Retrieves a reference to the canvas element (i.e., the DOM element mentioned 
above).

• Obtains a reference to a 2D drawing context.  The drawing context is used to draw
the graphics.

Note:  Currently, HTML5 only has support for a 2D graphics context.  The HTML5 
specification states there may be support for a 3D graphics context in a future version.
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__10. Add the following code to draw a green rectangle to the drawOnCanvas function:

// set fill color to green
ctx.fillStyle = "#00FF00";
// draw filled rectangle
ctx.fillRect(50, 50, 200, 150);

Notice the following:

• We used the fillStyle property of the context object to set the fill color to 
"#00FF00" (green).  

• We used the fillRect method of the context object to draw a filled rectangle.  
When drawing a rectangle, the fillRect method uses the current fillStyle, which 
defaults to black.

• fillRect takes 4 arguments:  x, y, width, and height.  x and y correspond with the 
upper left hand coordinates of the rectangle.

Note:  Remember that the origin (x = 0, y = 0) corresponds with the upper left hand 
corner of the browser window.  As you move to the right (along the x axis), x increases 
in value.  As you move down (along the y axis), y increases in value.
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Note:  When specifying the fillStyle color, you can specify a CSS color in hexadecimal 
format (e.g., "#00FF00"), in RGB format (e.g., "rgb(0, 255, 0)"), or using one of the 
predefined color names (e.g., "red"). 

Note:  If you don't want to create a filled rectangle, you can use the strokeRect method 
instead.  It has the same method signature as the fillRect method.

__11. Add the following code to draw the first diagonal to the drawOnCanvas function:

// trace first diagonal
ctx.moveTo(50, 50);
ctx.lineTo(250, 200);

moveTo(x, y) allow you to specify where to start drawing a line.  In this case, the starting
point for your line is the upper left corner of the rectangle.

lineTo(x, y) indicates where to draw the line to.  In this case, the end point for your line is
the lower right corner of the rectangle.

__12. In a similar manner, add the following code to draw the second diagonal:

// draw second diagonal
ctx.moveTo(250, 50);
ctx.lineTo(50, 200);

__13. Add the following code to render the two lines you drew in red ink to the 
drawOnCanvas function:

// draw diagonals in red
ctx.strokeStyle = "#FF0000";
ctx.stroke();

Technically, when you draw lines in HTML5, they're not displayed by default.  You need 
to tell the context object to render them using its stroke method.  One analogy that can be 
made is that you're drawing with a pen which is out of ink.  When you call the stroke 
method, you refill the pen with ink and retrace the lines (in this case, red ink, since the 
strokeStyle property was set to red).  

Note:  Technically, the above rule applies to all paths (complex objects).  A path is a set 
of subpaths.  A subpath is a set of one or more points connected by a straight line or a 
curved line.  When you drew the two diagonal lines, you created a path consisting of two
subpaths.    

__14. Save the file.
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Part 2 - Test

__1. Open Google Chrome.

__2. Navigate to the following URL:

http://localhost/canvas/drawOnCanvas.html

__3. You should see the following screen:

As expected, the canvas contains the drawing you created in the previous part.  However, 
notice that you can't see the border of the canvas. 

__4. Open drawOnCanvas.html.

__5. To see the border of the canvas, add the following style attribute to the canvas 
element:

<canvas id="c" width="400" height="300" 
  style="border: 1px solid #c3c3c3;">

__6. Save the file.
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__7. Refresh the page in the browser.

You should now see the edges of the canvas.  

Make sure that when you draw inside the canvas, you take into account the size of the 
canvas.  Let's see what happens if you don't.

__8.   Try changing the size of the rectangle to a value that exceeds the width of the 
canvas:

ctx.fillRect(50, 50, 500, 150);

__9. Save your changes.

__10. Refresh the page in the browser.

Notice that the rectangle is clipped.  Obviously, this isn't what we wanted.  
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__11. Change the rectangle width back to its original size and save your changes.

__12. Test again.

__13. Close the browser and the editor.

Part 3 - Review

In this lab, you learned how to use the canvas element to draw a filled rectangle and lines.
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	Lab 1 - Create a Basic HTML5 Layout
	Part 1 - Clear the Browser Cache and Location Settings
	__1. Open Chrome.
	__2. Click the icon to the right of the location bar and select Settings from the drop-down menu. Older Chrome versions will show Options instead of Settings.
	__3. Under Settings expand Show advanced settings...
	__4. Under Privacy click the Clear browsing data button.
	__5. Check all the checkboxes.
	__6. Select the beginning of time option from the Obliterate the following items from drop-down box.
	__7. Click the Clear browsing data button.
	__8. Click the Content settings button, which is located to the left of the Clear browsing data button.
	__9. Scroll down in the browser and click the Manage exceptions button under the Location section.
	__10. If any exceptions appear in the panel, select the exception and click the X to the right of it to delete the exception.
	__11. Click the X in the upper right corner of the Geolocation Exceptions panel to close the panel.
	__12. Click the X in the upper right corner of the Content Settings panel to close the panel.
	__13. Close the browser.

	Part 2 - Create the Template
	__1. From Applications open Brackets. Brackets is a text editor that was pre-installed for you. You do not need to use anything but a regular text editor for the labs but this program has some tools that can make it easier to work with the web pages you will be editing. Use the text editor of your preference.
	__2. If there is any opened file, close it.
	__3. From the menu, select File → New.
	__4. Enter the DOCTYPE declaration, followed by the html element:
	__5. Define the document's character encoding inside the head element as shown below.
	__6. Finally, add the body element and the html close tag to the document:
	Next, you will save the HTML file to the Apache Web Server document root.
	__7. Open Windows Explorer.
	__8. Open Finder and locate the htdocs folder under your user folder. If this folder doesn't exist then create it. For example UsersYouUserNamehtdocs
	__9. Create a folder called layout under the htdocs folder.
	__10. Save the HTML file in this folder as html5Template.html within the layout folder.

	Part 3 - Test
	__1. Open the Chrome browser.
	__2. Enter the following URL into the address bar:
	__3. You should see the following screen:
	
	__4. Close the all.

	Part 4 - Review

	Lab 2 - Improve Your Forms Using HTML5
	Part 1 - Create an Input Form Using the New HTML5 Input Types
	__1. Open layouthtml5Template.html. This should be under UsersYouUserNamehtdocs folder.
	__2. Save the file as registerEmployee.html in the same folder.
	__3. Change the title content to:
	__4. Remove the content inside the body element.
	__5. Add the following code inside the body element:
	__6. Add the following form element:
	__7. Add a label and a corresponding text field for the employee's name inside the form element:
	__8. Add a label and an e-mail field for the employee's e-mail:
	__9. Add a label and a date field for the employee's date of birth.
	__10. Add a label and a number field for the employee's age:
	__11. Add a label and a range field for the employee's number of years of experience:
	__12. Add a label and a text field for the employee's phone number:
	__13. Finally, add a submit button to allow the user to submit the form and a label indicating that any fields with an asterisk (*) next to them are required.
	__14. Save and close the file.
	__15. Copy LabFilesthankYou.html to htdocslayout, since the form submits to that page.

	Part 2 - Test
	__1. Open Google Chrome.
	__2. Navigate to the following URL:
	__3. You should see the following screen:
	__4. Also, notice the following:
	__5. Input the following values:
	__6. Submit the form by clicking Register.
	__7. You should see the thank you page.
	__8. Click the Back button (left arrow).
	__9. Delete the text in the full name field.
	__10. Try submitting the form.
	__11. You should see the following error message:
	__12. Enter Mike Harris back into the full name field.
	__13. Change the e-mail address from mharris@yahoo.com to mharris.
	__14. Try submitting the form.
	__15. You should see the following error message:

	Part 3 - Display the Value of the Range Field
	__1. Open registerEmployee.html.
	__2. First off, add a span element to the right of the range field. The span element will display the value the user selected for the number of years of experience:
	__3. Next, add an onchange event handler to the range field that gets called after the user drags the slider to a new position:
	__4. Add a script element before </head>.
	__5. Add the event handler function, displayRating, inside the script element:
	__6. Save your changes.
	__7. Close all open browsers.
	__8. Navigate to the following URL:
	__9. Drag the slider all the way to the right. Make sure the value increments in steps of 1 and reaches a maximum value of 100.
	__10. Now drag the slider all the way to left. Make sure the value decrements in steps of 1 and reaches a minimum value of 0.

	Part 4 - Troubleshooting JavaScript Problems in Chrome
	__1. Change the code as shown in bold below:
	__2. Save the file.
	__3. Refresh the browser to pick up the changes.
	__4. Try dragging the slider.
	__5. Select Tools->Developer tools from the menu bar.
	__6. The Developer tools should appear in the lower half of the browser window. Click the Sources tab and expand the html code.
	__7. Click the Console tab.
	__8. Click the registerEmployee.html:9 link.
	__9. Chrome will show you the offending line of code in the Scripts tab.
	__10. Fix the error in the code.
	__11. Save your changes and refresh the page.
	__12. Now try dragging the slider. The value should be updated and you should see no red Xs in the Developer Tools.
	__13. Click on the Sources tab inside the Developer Tools panel.
	__14. Click inside the gray margin to the left of the document.getElementById() line of code inside the displayRating function.
	__15. Verify a breakpoint symbol (blue arrow) appears.
	__16. Try dragging the slider.
	__17. Verify that the breakpoint was hit. The line of code should now appear in blue.
	__18. In the right panel, look inside the Scope Variables panel and you'll see the slider variable listed. 
	__19. Expand it and you can see the value of its properties.
	__20. To execute the line of code, click the Step over next function call button in the toolbar at the top of the panel.
	__21. The cursor should advance to the next line of code.
	__22. Click the Resume script execution button (to the left of the Step over next function call button) to resume running the script.
	__23. Remove the breakpoint by clicking on the blue arrow in the margin. The arrow should disappear.
	__24. Close the Developer Tools by selecting Tools->Developer tools from the menu bar.

	Part 5 - Display the Value of the Range Field Using the Output Element
	__1. Replace the span element:
	__2. Add the 'oninput' attribute below to the 'rating' input element, so that it looks like so:
	__3. Delete the script element, containing the displayRating function, since it's no longer needed.
	__4. Save your changes.
	__5. Refresh the browser. You should now see 0 for the number of years of experience listed to the right of the slider.
	__6. Drag the slider all the way to the right. Make sure the value increments in steps of 1 and reaches a maximum value of 100.
	__7. Now drag the slider all the way to left. Make sure the value decrements in steps of 1 and reaches a minimum value of 0.

	Part 6 - Style the Error Fields
	__1. Add the following style element before </head>:
	__2. Save and close the file.
	__3. Refresh the page.
	__4. Input Mike Harris for the full name.
	__5. Now input mharris@yahoo.com for the e-mail.
	__6. Repeat this process for the remaining fields.
	__7. Submit the form. You should see the thank you page.
	__8. Close the browser.

	Part 7 - Review

	Lab 3 - Drawing Using the Canvas Element
	Part 1 - Create a 2D Drawing Using the Canvas Element
	__1. Create a new folder called canvas within the htdocs folder.
	__2. Open htdocslayouthtml5Template.html and save it as drawOnCanvas.html in the canvas folder.
	__3. Change the title content to:
	__4. Remove the content inside the body element.
	__5. Add a canvas element inside the body element:
	__6. Add an onload event handler to the body element:
	__7. Add the following script element before </head>:
	__8. Add the declaration for the drawOnCanvas function before </script>:
	__9. Add the following variable declarations inside the drawOnCanvas function:
	__10. Add the following code to draw a green rectangle to the drawOnCanvas function:
	__11. Add the following code to draw the first diagonal to the drawOnCanvas function:
	__12. In a similar manner, add the following code to draw the second diagonal:
	__13. Add the following code to render the two lines you drew in red ink to the drawOnCanvas function:
	__14. Save the file.

	Part 2 - Test
	__1. Open Google Chrome.
	__2. Navigate to the following URL:
	__3. You should see the following screen:
	__4. Open drawOnCanvas.html.
	__5. To see the border of the canvas, add the following style attribute to the canvas element:
	__6. Save the file.
	__7. Refresh the page in the browser.
	__8. Try changing the size of the rectangle to a value that exceeds the width of the canvas:
	__9. Save your changes.
	__10. Refresh the page in the browser.
	__11. Change the rectangle width back to its original size and save your changes.
	__12. Test again.
	__13. Close the browser and the editor.

	Part 3 - Review

	Lab 4 - Intro to CSS3
	Part 1 - Copy Files
	__1. Open a file browser window.
	__2. Go the 'LabFiles' folder and copy the entire 'css3' folder. Make sure you copy the correct one as there may be another folder with a similar name.
	__3. Navigate to the 'htdocs' folder of where the Apache web server was installed.
	__4. Paste the entire 'css3' folder to create the folder 'htdocscss3'.

	Part 2 - Observe Style Changes
	__1. Open a web browser and go to the following URL:
	__2. Observe the appearance of the page. Take note of the colors, style and size of the text, etc. These will change somewhat when you alter the styles in the page.
	__3. Leave the browser open to the page as you will refresh it later.
	__4. Open the following file with a text editor as Brakets:
	__5. Observe how currently there are some <style> definitions near the top of the page that are modifying how the browser displays the page.
	__6. Modify the 'color' properties of the two existing styles as shown in bold below.
	__7. Save the file but leave it open.
	__8. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__9. Observe how the color of the text at the top of the page changes colors with the change to the style.
	__10. Return to the editor that was editing the page and modify the 'font-weight' property as shown in bold below.
	__11. Save the file but leave it open.
	__12. Return to the browser showing the page and refresh the page again. Notice how the text that is currently red and the text that is green both become bold.
	__13. Close all open files and browsers.

	Part 3 - Review

	Lab 5 - Applying Basic Styles
	Part 1 - Verify Files
	__1. Open a file browser window like Finder.
	__2. Navigate to the 'htdocs' folder of where the Apache web server was installed.
	__3. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Inline Style
	__1. Open a web browser and go to the following URL:
	__2. Observe the appearance of the page. Take note of the colors, style and size of the text, etc. These will change somewhat when you alter the styles in the page.
	__3. Leave the browser open to the page as you will refresh it later.
	__4. Open the following file with a text editor:
	__5. Find the first '<h1>' tag and add the 'style' property as shown in bold below. Make sure you have proper syntax including the quotes and the colon and semi-colon in the style rule.
	__6. Save the file but leave it open.
	__7. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__8. Observe how the color of the text at the top of the page changes colors with the change to the style.

	Part 3 - Embedded Style
	__1. Return to the editor that was editing the page. Modify the existing '<style>' tag by adding a new style rule for the paragraph (<p>) element as shown in bold below.
	__2. Save the file but leave it open.
	__3. Return to the browser showing the page and refresh the page again. Notice that now the paragraph text is a different color, has a little more space between lines and is indented.

	Part 4 - Style Class
	__1. Return to the editor that was editing the page. Modify the existing '<style>' tag by adding a new 'chaptertitle' style class definition as shown in bold below. Make sure to include the '.' selector before the name of the class so this can be applied to any element in the page.
	__2. Scroll down to the second <h1> element and notice that part of it already has a <span> tag that applies the 'chaptertitle' style. This was so another lab could show two different colors by using the style class. You do not have to modify anything here.
	__3. Find the link anchor tag (<a>) near the bottom of the page and add the 'class' property with the name of the new class as shown in bold below.
	__4. Save the file but leave it open.
	__5. Return to the browser showing the page and refresh the page again. Notice how the text of the chapter title at the top and on the link at the bottom both change. Probably the easiest way to detect they have changed is they are both in small capital letters now.
	__6. Return to the editor that was editing the page. Modify the existing '<style>' tag by adding a new 'a.chaptertitle' style class definition as shown in bold below. This is a “dependent” class that can only be applied to the anchor (<a>) element.
	__7. Save the file but leave it open.
	__8. Return to the browser showing the page and refresh the page again. Notice that nothing else on the page changes but the size and style of the link text changes. The dependent class only applied to this element.

	Part 5 - Link to Stylesheet
	__1. Return to the editor that was editing the page. Before the existing <style> tag, add a new <link> tag as shown in bold below.
	__2. Save the file but leave it open.
	__3. Return to the browser showing the page and refresh the page again. Now the text should have quite a bit of padding on the top and left of the page.
	__4. Return to the editor editing the page. Within the existing <style> tag add the following '@import' rule in bold. Make sure it is at the top of the content of the <style> tag.
	__5. Save the file but leave it open.
	__6. Return to the browser showing the page and refresh the page again. Now you should have an image that fills in some of the empty space that was created.
	__7. If you want you can open the following files and look at some of the style rules that have made the changes you saw.
	__8. Close the files when you finished reviewing the files.

	Part 6 - Pseudo-Classes
	__1. Return to the editor editing the page. Within the existing <style> tag add the following pseudo-class definitions in bold. Notice that they contain a colon (':') and not a period because the link state the style applies to comes after the colon.
	__2. Save the file but leave it open.
	__3. Return to the browser showing the page and refresh the page again. Notice the style of the link has changed as as you hover over it or click it the color changes. The file the link is supposed to point to doesn't exist so you will get an error if you follow the link but you should still see the various changes as the mouse interacts with the link.
	__4. Close all open browsers.

	Part 7 - Review

	Lab 6 - Modify Text Styles
	Part 1 - Verify Files
	__1. Open a file browser window.
	__2. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Define Font Family
	__1. Open a web browser and go to the following URL:
	__2. Observe that right now the text does not really have much style applied to it but this will change as various style properties are added.
	__3. Leave the browser open to the page as you will refresh it later.
	__4. Open the following file with a text editor:
	__5. Notice that the page already has a link to a stylesheet of the name 'font‑properties.css'. Rather than defining styles directly in the page we will edit this file.
	__6. Close the 'index.html' file.
	__7. Open the following file with the text editor:
	__8. Add the 'font-family' property to the 'body' style as shown in bold below. Make sure the entire name of the 'Times New Roman' font is in quotes.
	__9. Save the file but leave it open.
	__10. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__11. You may not see a big change but there should be some subtle differences in the font. This may be because your browser is now using one of the fonts in the 'font family' list instead of the default font for the browser.
	__12. Return to the editor that was editing the 'font‑properties.css' file. Modify the other style rules that are currently empty to add the 'font‑family' property shown in bold below.
	__13. Save the file but leave it open.
	__14. Return to the browser that was showing the page and refresh the page.
	__15. Observe that the font styles used by the various headers at the top of the page change as they are now using some type of “sans‑serif” font.

	Part 3 - Use Web Fonts
	__1. Open the following file in the editor:
	__2. Modify the name of the file linked to as the stylesheet as shown in bold below. Since web fonts require quite long style rules we will provide much of it for you to avoid typos.
	__3. Save the 'index.html' file.
	__4. Open the following file with the text editor:
	__5. Observe the various '@font-face' rules, one example of which is shown below. The most important property is the 'font-family' property which can be a name of your choosing. We will see this show up later. Also notice that there are various 'url(...)' functions linking to files that were copied to the web server. There are several different URLs because different browsers (and versions) may use different file formats for web fonts.
	__6. Scroll to the bottom of the 'font-properties-webfont.css' file and find the various styles that had previously been defined in the other stylesheet file. Currently they are the same as they were in that file.
	__7. To use the web fonts we must reference the name given to it in the '@font-face' rules so add the following bold entries to the values of the various 'font‑family' style properties. Make sure to also add the comma between the new font name and the fonts that were already present. Also double check that the font name you add matches exactly the 'font‑family' property defined with the various '@font-face' rules.
	__8. Save the file but leave it open.
	__9. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__10. You should see that the fonts of the body and the headers change quite drastically as the web font is picked up instead of the “standard” fonts used before.

	Part 4 - Apply Font Effects
	__1. Return to the editor for the 'font-properties-webfont.css' file. Add the following new style rule in bold to display the '<h1>' elements in italic text.
	__2. Save the file but leave it open.
	__3. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__4. You should see the first line of text, the only thing to use the <h1> element, is now italic.
	__5. Return to the editor for the 'font-properties-webfont.css' file. Add the following new style rule in bold to display the 'author' style elements in all uppercase.
	__6. Save the file but leave it open.
	__7. Return to the browser that was showing the page and refresh the page.
	__8. You should see a change to the style of the authors name.

	Part 5 - Modify Text Alignment
	__1. Return to the editor for the 'font-properties-webfont.css' file. Modify the existing 'body' style rule to include the properties in bold below to justify text.
	__2. Save the file but leave it open.
	__3. Return to the browser that was showing the page and refresh the page.
	__4. You should see body text in the main content of the page is now justified instead of left-aligned.
	__5. Return to the editor for the 'font-properties-webfont.css' file. Add the following new style rule in bold to center <h2> elements.
	__6. Save the file but leave it open.
	__7. Return to the browser that was showing the page and refresh the page.
	__8. You should see the <h2> header text centered on the page.
	__9. Return to the editor for the 'font-properties-webfont.css' file. Modify the existing 'h2.chaptertitle' style rule to include the properties in bold below to adjust the size and vertical alignment.
	__10. Save the file but leave it open.
	__11. Return to the browser that was showing the page and refresh the page.
	__12. The chapter title is now bigger but middle aligned with the chapter number.
	__13. Close all open browsers.
	__14. Close all open files.

	Part 6 - Review

	Lab 7 - Control Element Spacing with Box Properties
	Part 1 - Verify Files
	__1. Open a file browser window.
	__2. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Control Height and Width
	__1. Open a web browser and go to the following URL:
	__2. Get familiar with the current style of the page. In particular notice there are some images (HTML5 <figure> tags) that we will control text flow around in one part of the lab.
	__3. Leave the browser open to the page as you will refresh it later.
	__4. Open the following file with a text editor. This is a stylesheet currently linked from the index.html file (along with some other stylesheets for font and text styles).
	__5. Add the following width and height properties in bold to the currently empty 'header' style.
	__6. Save the file but leave it open.
	__7. Return to the browser that was showing the page, make sure you are viewing the top headers of the page, and refresh the page. Open a new one to the following URL if you closed it:
	__8. You should see that the chapter number and title are a little closer vertically than they were to the author name on the right. If you were not viewing the top of the page before you did the refresh this might be hard to detect.
	__9. If your browser window is currently maximized, used the 'restore' button so you can resize the browser window.
	__10. Drag the width of the browser window to make it much narrower and see if the various elements in the header start overlapping badly with each other. This is because the word wrapping of the header is now causing it to want to use more height than we allowed and it is overlapping the next element. You might also see that the chapter title is wrapping as well.
	__11. Return to the editor that was editing the 'box‑properties.css' file. Add the following properties in bold to the currently empty 'h1' and 'article' styles.
	__12. Save the file but leave it open.
	__13. Return to the browser that was showing the page and don't change the width of the browser window but refresh the page.
	__14. You should see that the various text at the top of the page doesn't do as much word wrapping because of the 'min-width' properties in particular so things likely will not overlap anymore.
	__15. Gradually expand the width of the browser window and you should see the chapter title and number move right a little once the window is wider than the minimum width of the <article> content. Depending on your screen size you may also see that eventually the content starts leaving more empty space on the right because you have hit the maximum width value.
	__16. Scroll to the very bottom of the page and notice there is an 'About the Author' section which is an HTML5 <aside> element.
	__17. Return to the editor that was editing the 'box‑properties.css' file. Add the following properties in bold to the currently empty 'aside' style.
	__18. Save the file but leave it open.
	__19. Return to the browser that was showing the page and refresh the page while still looking at the bottom of the page.
	__20. You should now see that this section is narrower. It is hard to tell but the height should be taller than the value of the 'height' property.
	__21. Return to the editor that was editing the 'box‑properties.css' file. Add the following new 'overflow' property in bold to the 'aside' style.
	__22. Save the file but leave it open.
	__23. Return to the browser that was showing the page and refresh the page while still looking at the bottom of the page.
	__24. You should now see that the 'height' style property is honored and a scrollbar is added to scroll through the text within the allowed space.

	Part 3 - Text Flow
	__1. Return to the editor that was editing the 'box‑properties.css' file.
	__2. Add the following new style classes in bold to the stylesheet. Make sure they are not embedded within the brackets of another style.
	__3. Save the file but leave it open.
	__4. Return to the browser that was showing the page and refresh the page.
	__5. Find the images in the file and notice now that text flows around them. Before there was blank space next to the images and the text didn't pick up again until after the image.  The images had already indicated they were using the 'floatleft' or 'floatright' style classes but without these classes being defined that was ignored.  Now that you defined that class and used the 'float' property the text flows differently.
	__6. Scroll to the top of the page and look at the first letter of the first paragraph. There is an existing style that makes the letter larger and with a shadow but notice it sticks up above the top of the line for the rest of the text.
	__7. Return to the editor that was editing the 'box‑properties.css' file.
	__8. Add the following new style in bold to the stylesheet. Be careful with the syntax of the name of the style as it must select the same element as the existing style (in text‑properties.css) that creates the larger first letter.
	__9. Save the file but leave it open.
	__10. Return to the browser that was showing the page and refresh the page.
	__11. You should now see that the letter drops down with the first few lines of text flowing around it and a very small margin. Depending on the browser you may see that the letter is aligned in different way. Using three values for the 'margin' property we are setting top, left/right, and bottom.
	__12. In the browser find one of the figures with the text that now flows around it. Depending on the browser you may see that the text is either close to or further away from the figure. Try the page in different browsers to see this.
	__13. Return to the editor that was editing the 'box‑properties.css' file.
	__14. Add the following new style in bold to the stylesheet.
	__15. Save the file but leave it open.
	__16. Return to the browser that was showing the page and refresh the page.
	__17. You should now see that the margin around the figure is more consistent between browsers.

	Part 4 - Border and Padding
	__1. Return to the editor that was editing the 'box‑properties.css' file.
	__2. Add a new property to the 'figure' style and a new 'figcaption' style as shown in bold below.
	__3. Save the file but leave it open.
	__4. Return to the browser that was showing the page and refresh the page. Find one of the images if you do not already see one.
	__5. You should see some blue borders around the image and the caption.
	__6. Return to the editor that was editing the 'box‑properties.css' file.
	__7. Add the 'padding' property to the existing 'figure' class as shown in bold below.
	__8. Save the file but leave it open.
	__9. Return to the browser that was showing the page and refresh the page.
	__10. You should now see a little space between the inside of the element border and the items inside of it. This is different than the 'margin' property which is the space between the element border and the items outside of it.
	__11. Close all open browsers.
	__12. Close all open files.

	Part 5 - Review

	Lab 8 - Intro to JavaScript
	Part 1 - Copy Files
	__1. Open a file browser window.
	__2. Go the 'LabFiles' folder and copy the entire 'JavaScript' folder. Make sure you copy the correct one as there may be another folder with a similar name.
	__3. Navigate to the 'htdocs' folder of where the Apache web server was installed. This should be the 'htdocs' folder.
	__4. Paste the entire 'JavaScript' folder to create the folder 'htdocsJavaScript'.

	Part 2 - Add Basic JavaScript Code
	__1. Open the following file with a text editor:
	__2. After the existing <noscript> tag but before the ending </body> tag, add the following bold code. This will use JavaScript to write out a simple message.
	__3. Save the file but leave it open.
	__4. Open a web browser and go to the following URL:
	__5. Observe that the JavaScript code has written out the message to the content of the page.
	__6. Leave the browser open as you will refresh the same page in the next part.

	Part 3 - Link to External Script File
	__1. Return to the editor that was editing the 'intro.html' page.
	__2. Add the following link to the external script file in bold in the <head> section of the page.
	__3. Save the file but leave it open.
	__4. Open the following file with a text editor:
	__5. Into the currently empty file add the following line.
	__6. Save the file but leave it open.
	__7. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__8. Immediately after you reload the page you should see a dialog box with the message. The dialog itself may vary slightly depending on the browser but you should easily recognize the message.
	__9. Click the OK button to close the dialog and you should still see the message printed by the code directly in the page.
	__10. Close all open browsers.
	__11. Close all open files.

	Part 4 - Review

	Lab 9 - Basic JavaScript Syntax
	Part 1 - Verify Files
	__1. Open a file browser window.
	__2. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Variables
	__1. Open the following file with a text editor:
	__2. There is already an empty function declared that will be called when the page loads. To the top of this empty function add the following line in bold.
	__3. To complete the function add the following bold code. This will check if there was any value returned by the prompt dialog and use it if there was.
	__4. Save the file but leave it open.
	__5. Open a Chrome web browser and go to the following URL:
	__6. When the page first loads you should see a prompt. Fill in a value and click the OK button.
	__7. You should see the dialog change to the show the message. Click the OK button.
	__8. Check that you have the same message written out to the page.
	__9. You can refresh the page and supply a different message.

	Part 3 - Handle Errors
	__1. Open the following file with a text editor:
	__2. Add the following bold code to the existing 'initAll' function.
	__3. Save the file but leave it open.
	__4. Open a Firefox or Chrome web browser and go to the following URL:
	__5. When the page first loads you should see a prompt. Fill in a value and click the OK button. Start by using a valid positive number.
	__6. You should see a dialog that shows the square root of your number.
	__7. Click the OK button on the dialog and you should see the same message printed to the page.
	__8. Reload or refresh the page and this time enter an invalid response like a negative number or text that is not a number.
	__9. You should see a dialog that says the entry is not a valid number and nothing should be displayed on the page.

	Part 4 - Modify Style of Page Elements
	__1. Open the following file with a text editor:
	__2. Observe that the main HTML code for the body of the page is a text box for the user to enter a value in and a button. This button will trigger a JavaScript function. There are also some other page elements with text that will have the styles changed. Notice all the elements have the 'id' attribute.
	__3. Close the file without making any changes.
	__4. Open the following file with a text editor:
	__5. In the currently empty 'initAll' function, add the following bold line of code. This will modify the button so that when it is clicked it will call the other function in this file.
	__6. In the currently empty 'findById' function, add the following bold lines of code. This uses the 'getElementById' function of the built-in 'document' object which is a key part of the DOM API. This code finds out what the user filled in for the textbox and then finds the element with that id to modify the style to yellow background.
	__7. Save the file but leave it open.
	__8. Open a web browser and go to the following URL:
	__9. In the textbox of the page enter the id of one of the elements (these are in parenthesis) and then click the 'Find by ID' button.
	__10. You should see that the background of the matching element changes.
	__11. Try entering the id of some of the other elements. Also try a value that is not a valid element id and verify the error dialog appears.

	Part 5 - Object Detection
	__1. Open the following file with a text editor:
	__2. In the current 'initAll' function, add the following if/else statements in bold. Leave some space in the 'if' block as more code will be added there.
	__3. Within the 'if' block you just added, add the following code in bold. Make sure that you put in the correct number of curly brackets so they match.
	__4. Save the file but leave it open.
	__5. Open a web browser (any type) and go to the following URL:
	__6. Verify that you get a popup dialog that shows the current time and date.
	__7. After clicking the OK button you should also see this printed to the page, likely in a large bold <h1> element.
	__8. Close all open browsers.
	__9. Close all open files.

	Part 6 - Review

	Lab 10 - JavaScript Functions
	Part 1 - Verify Files
	__1. Open a file browser window.
	__2. Navigate to the 'htdocs' folder of where the Apache web server was installed. This should be the 'Apache2.2htdocs' folder.
	__3. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Return Result from Function
	__1. Open the following file with a text editor:
	__2. To the existing 'generateNumber' function add the following bold code. This will return a bingo number which are between 1-75.
	__3. To the existing 'displayNumber' function add the following bold code. This will call the other function and store what is returned in a variable. The result will then be used to display a message to the page.
	__4. Save the file but leave it open.
	__5. Open a web browser (any type) and go to the following URL:
	__6. Click the 'Pick a BINGO Number' button and verify a number is displayed. You can click several times to verify they are randomly picked and always between 1-75.
	__7. Leave the browser displaying the page open.
	__8. Return to the editor for the 'bingo.js' file.
	__9. Modify the entire content of the 'generateNumber' function with the new code in bold below. This will return an array with the letter for the column along with the number picked.
	__10. Make the following small modification to the end of the 'displayNumber' function. Notice that most of the code is the same except where the message is altered with the number that is returned. Now the column letter and number will be displayed.
	__11. Save the file.
	__12. Return to the browser showing the page and refresh the page. Open a new window to the following location if you closed it.
	__13. Click the 'Pick a BINGO Number' button and verify that now the column letter and the number are displayed. You can click several times to verify that the number is always within the appropriate range for the column chosen.

	Part 3 - Pass Function Parameters
	__1. Open the following file with a text editor:
	__2. Examine the existing code in the 'initAll' function. It will prompt for a number and check if it is a positive integer number entered by the user.
	__3. Add the following bold line of code where the comment indicates. This will call a function that you will define next. Notice it will take a parameter for the value the user entered.
	__4. At the end of the file, add the following declaration of the new function. Make sure to add it outside of any other current function and add the matching curly bracket on the end of the function. Notice this function declares the parameter that it takes but does not declare the type of data it might hold like some other programming languages might.
	__5. Within the brackets for the new function declaration, add the following bold code. This will check each number within the range by calling another function to test that specific number. The number is added to a String of all the prime numbers if it is found to be prime.
	__6. To complete the 'calculatePrimes' function, add the bold code below. This will remove the trailing comma at the end of the prime number list amd call another function to display the list on the page.
	__7. At the end of the file, add the following declaration of a new function. Make sure to add it outside of any other current function and add the matching curly bracket on the end of the function.
	__8. Within the brackets for the new function declaration, add the following bold code. This code will check to see if it is possible to evenly divide the number being checked by any of the numbers less than or equal to the square root of a number. If it is found to be divisible a response is immediately returned that it is not a prime number. If the loop completes and no divisors have been found it is a prime number.
	__9. At the end of the file, add the following declaration of a new function. This will be the function to display the list of prime numbers on the page. Notice that it takes two parameters which will be used in the output.
	__10. Within the brackets for the new function declaration, add the following bold code. This code will display the number the user entered to use as the maximum number to check and display a message. Usually the message will be the list of prime numbers but another message will be displayed if there are none.
	__11. Save the file but leave it open.
	__12. Open a Chrome web browser and go to the following URL:
	__13. Enter a positive number in the dialog and click the OK button.
	__14. Check that you get the expected output printed to the page including a list that has no comma after the last number.
	__15. You may refresh the page and enter another maximum number to check for prime numbers.
	__16. Close all open browsers.
	__17. Close all open files.

	Part 4 - Review

	Lab 11 - Arrays in JavaScript
	Part 1 - Verify Files
	__1. Open a file browser.
	__2. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Use Array to Track Bingo Card Numbers
	__1. Open the following file with a text editor:
	__2. Most of this HTML code is standard with a link to a CSS stylesheet and the external JavaScript file you will edit in a few steps. The important part of this code is that there is a table with 5 columns and table cells that have an id of 'squareXX' where 'XX' is a number between 0-23. These would be the valid array indexes in an array with 24 elements which is what we need since the middle square is a “free” space and doesn't need a number.
	__3. Close the file without making any changes.
	__4. Open the following file with a text editor:
	__5. Look for the code at the very top of the file and add the following bold line where the comment mentions a global array. This array will be used to store whether or not a particular number has been used for this bingo card.
	__6. Examine the first few lines of the 'setSquare' function. This function is called to initialize the number for each of the squares in the bingo card. The 'colPlace' array is created and initialized with various numbers 0-4. These represent the column index the various squares are related to.
	__7. Add the following bold line of code to calculate the “column basis”. This is a number that will be added to a random number generated in later code and represents the range of numbers allowed in a particular column. Notice the square number is used to find the multiplier from the 'colPlace' array.
	__8. Fill in the condition of the do/while loop to use the value stored in the 'usedNums' array to indicate if the number has been used in this bingo card yet or not. Also add code after the loop to mark the position in this 'usedNums' array as being used. Notice how the random number generated is used as the index into this array which is why we wanted 1‑75 to be valid indices in this array.
	__9. Find the 'anotherCard' function and add the following 'for' loop in bold. This will reset all of the positions in the 'usedNums' array to be 'false' when generating another bingo card.
	__10. Save the file but leave it open.
	__11. Open a web browser and go to the following URL:
	__12. Verify that you see the bingo card displayed. Check that all squares are filled in with numbers that are legal for that column (1-15 for B, 16-30 for I, etc).
	__13. Click on the “Click here” link a few times to generate a new bingo card and ensure that functions properly. You should check that numbers that had been used on the previous cards are also used on future cards to verify the array for used numbers is being reset. Also check that numbers from the edges of the column range (1 & 15, 16 & 30, etc) are being used.
	__14. If you want you can even click on a square to use an existing function that will mark the square red.

	Part 3 - Use Array for Prime Numbers
	__1. Open the following file with a text editor:
	__2. Examine the logic of the 'initAll' function but don't make any changes.  This code will prompt the user for how many prime numbers to calculate and make sure they enter a whole number that is greater than or equal to 1.
	__3. Find the 'calculatePrimesArray' function and add the bold line of code below at the beginning to declare and initialize an empty array to store the prime numbers that are found.
	__4. Find the 'if' test that comes next and add the bold line below to manually add the value '2' as the first prime number. Manually adding the first prime number will make other code simpler because it will not have to deal with the possibility that the array is empty (zero length).
	__5. Further down in the 'calculatePrimesArray' function, fill in the condition of the 'while' loop as shown in bold below so it checks the length of the array to see if enough prime numbers have been found. Since the first prime number is added manually, it is important the loop condition does not use '<=' so that it will behave properly (by skipping the loop) if the user only asks for one prime number.
	__6. Near the end of the 'while' loop add the bold line of code below to push the value into the array of primes if the function that is called to test the number returns that it is a prime number. You will add some code to this function next.
	__7. Notice the end of this function calls another function to display the prime numbers and passes in the array as a parameter. You do not need to change this code.
	__8. Find the 'testForPrime' function and notice that the function declaration takes the number to test and the current array of prime numbers. This is key to using the array of prime numbers to make the test more efficient.
	__9. Fill in the conditions for the 'for' loop and 'if' statement as shown in bold below using the elements of the 'primes' array and the index 'I' declared by the 'for' loop. The 'for' loop condition checks if the current prime number being used is less than or equal to the square root of the number being tested. The 'if' statement condition checks if the current number being tested is evenly divisible by the current prime number and if it is immediately returns 'false' because the number being tested is not a prime number.
	__10. Find the 'displayPrimes' function and add the code in bold at the end of the function to add the array of primes to the display text.
	__11. Save the file but leave it open.
	__12. Open a Firefox or Chrome web browser and go to the following URL:
	__13. When the page first loads you should see a prompt. Fill in a value and click the OK button.
	__14. You should see the expected output which includes the list of prime numbers. Notice how simply adding the entire array to the display text converted the array values into a comma-separated list.
	__15. Refresh the page and when the prompt displays enter a large value like 100 for the number of prime numbers to calculate.
	__16. You should notice that all the numbers remain on one line which causes the numbers to go well off the edge of the screen. If you wanted to see all of the numbers you would need to scroll to the right on the page. This is because there are no spaces for the browser to break the line at.
	__17. Return to the editor for the 'primeArrays.js' file and open it again if you closed it.
	__18. Find the 'displayPrimes' function again and add the following code to create a comma-separated String of the array of prime numbers that has a space after each comma.
	__19. Change the last line of code of the function as shown in bold below so that the String of prime numbers is added to the display text instead of the array itself.
	__20. Save the file.
	__21. Return to the browser showing the page and refresh the page. Open a new window to the following location if you closed it.
	__22. When the prompt displays enter a large value like 100 for the number of prime numbers to calculate.
	__23. Verify that now the output off the prime numbers breaks across multiple lines and you do not need to scroll to the right. This is because with the spaces in the String, the browser is able to break the String to the next line when it reaches the right edge of the window.
	__24. Refresh the page again and enter a very large number (about 10,000) for the number of prime numbers to calculate. You should see that the page is still displayed relatively quickly thanks to the optimizations made.
	__25. Close all open browsers.
	__26. Close all open files.

	Part 4 - Review

	Lab 12 - Media Queries and Responsive Design
	Part 1 - Verify Files
	__1. Open a file browser window.
	__2. Navigate to the 'htdocs' folder of where the Apache web server was installed. This should be the 'htdocs' folder.
	__3. Verify that the following sub folder has been copied to where the Apache server is installed. There will be various files within this subfolder.

	Part 2 - Reset Styles
	__1. Open a web browser and go to the following URL:
	__2. Get familiar with the current style of the page so you can notice as changes are made.
	__3. Leave the browser open to the page as you will refresh it later.
	__4. Open the following file with a text editor.
	__5. Don't make any changes but notice that this style sheet has many properties that are being "reset" to certain values.  These are the properties that might have different default values between browser types so applying this style sheet will override these defaults so they are consistent.
	__6. Close the style sheet without making any changes.
	__7. Open the following file with a text editor:
	__8. Near the top of the page and after the <title> but before the end of the </head> section, add the link to the reset style sheet as shown in bold below.
	__9. Save the file but leave it open.
	__10. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__11. What you should see is that the styles of the page are very different because of the "reset" style sheet.
	__12. Leave the browser open to the page as you will refresh it later.
	__13. Return to the editor that was editing the 'index.html' file.
	__14. Add the following bold code after the "reset" style sheet but again before the end of the </head> section. This will add a link to the "default" style sheet to apply to the page.
	__15. Save the file but leave it open.
	__16. Return to the browser that was showing the page and refresh the page. You should see that the page is now styled with some basic styles that should make it easy to read no matter what format the browser displays it as.
	__17. Leave the browser open to the page as you will refresh it later.

	Part 3 - Use Media Queries
	__1. Return to the editor that was editing the 'index.html' file.
	__2. Add the following bold code before the <title> tag but still inside the starting <head> tag. This will add the "viewport" meta tag to the page.
	__3. Add the following bold code before the end </head> tag. You can split the media query across multiple lines as long as the entire value is surrounded by a single set of quotes.
	__4. Save the file but leave it open.
	__5. If you are not already using it, open Firefox or Chrome to the following location. Refresh the page if you were already using Firefox or Chrome.
	__6. You should notice some different colors and some additional space between the text and the image. You may need to make the window wider to see the expected results. If you browser window is too small you won't see it.
	__7. Leave the browser open to the page as you will refresh it later.
	__8. Return to the editor that was editing the 'index.html' file.
	__9. Add the following bold code after the first media query <link> tag but again before the end </head> tag. You can split the media query across multiple lines as long as the entire value is surrounded by a single set of quotes.
	__10. Save the file but leave it open.
	__11. Return to the Firefox or Chrome window you were using and refresh the page. Open the following location with Firefox or Chrome if you had closed it. Maximize the browser.
	__12. You should now see a very different layout and style for the page. Make sure your window is maximized and check your screen resolution if you do not see the change. This is what would be shown perhaps on "normal" web browsers on a computer desktop.
	__13. Open the page in Firefox if you do not already have it open.
	__14. In Firefox, select 'Tools → Web Developer → Responsive Design View'. You may also need to click the 'Firefox' menu in the upper left to see the options below. Still another option could be just pressing the Ctrl-Shift-M short-cut.
	__15. Use the drop-down at the top of the window to select the '360x640' option. The page should be displayed with the default styles as both media queries will now be false. This is what the page might look like on a phone.
	__16. Use the drop-down to select the preset of '768x1024'. You should see the page displayed with the "medium" styles.
	__17. Click the 'rotate' button next to the drop-down list. The value won't change but the page should be wider and it should now be displayed with the "large" styles.
	__18. Click the X at the top left of the window next to the drop-down for screen sizes. This will close the responsive design view.

	Part 4 - Style for Print (optional)
	__1. Return to the browser that was showing the page and refresh the page. Open a new one to the following URL if you closed it:
	__2. Depending on the browser you are using open the 'Print Preview' of the page. Ask other students or the instructor if you are not sure how to do this.
	__3. What you should see is that the page is displayed with the "reset" styles only being applied. This is because all of the other styles were applied to the 'screen' media which is the visual display of the page.
	__4. Close the print preview view but leave the browser open.
	__5. Return to the editor that was editing the 'index.html' file.
	__6. Add the following bold code after the two media query <link> tags but again before the end </head> tag.
	__7. Save the file but leave it open.
	__8. Return to the browser that was showing the page and refresh the page.
	__9. What you should see is that the page doesn't change because the styles added only apply to the 'print' media and not the 'screen' which is the visible window.
	__10. Again open the print preview view.
	__11. You may or may not see an image in the upper left but you should at least be able to tell that the styles are different for how the page would be printed.
	__12. Close all open browsers.
	__13. Close all open files.

	Part 5 - Review

	Lab 13 - Responsive Layout
	Part 1 - Get Started
	__1. Create a folder called lab under htdocs.
	__2. Copy responsive_layout.html from LabFiles to /htdocs/lab.

	Part 2 - The First Run
	__1. Open an instance of Firefox and navigate to:
	__2. In Firefox, open Developer from the menu and select the Responsive Design View of the loaded page.

	Part 3 - Make the Page Responsive
	__1. Open the /htdocs/lab/responsive_layout.html page in your editor.
	__2. Enter the following code just above the </style> tag:
	__3. Update each div section's class by adding floatLeft as the second style class after the primary one (named col_X, where X takes 1, 2, or 3) so that your div sections will look as follows:
	__4. Save the page in your editor.
	__5. Switch to Firefox and reload the page.
	__6. Now, when you resize the page, you should see the expected behavior of the page that fluidly accommodates the columns as the screen width changes.

	Part 4 - View Page with Chrome's Mobile Browser Emulator
	__1. Start Chrome browser and navigate to:
	__2. Open the Developer Tools.
	__3. Click the Toogle device toolbar icon. This may change between versions.
	__4. Select iPhone 6.

	Part 5 - Improve Page Responsiveness with the Viewport Meta Tag
	__1. Switch to the editor window open on responsive_layout.html.
	__2. Enter the following code just below <title>Responsive Layout</title>:
	__3. Save the file.
	__4. Switch back to Chrome and reload the page.

	Part 6 - Lab Session Clean Up
	__1. In Chrome browser, Click the Toogle device toolbar icon again to close it. This may change between versions.
	__2. Close Chrome.
	__3. Switch to Firefox, close the Responsive Design View window by clicking the X. This may vary between versions.
	__4. Close Firefox.
	__5. Close the editor.

	Part 7 - Review

	Lab 14 - Orientation Responsiveness
	Part 1 - Get Started
	__1. Copy responsive_orientation.html from LabFiles to /htdocs/lab.

	Part 2 - The First Run
	__1. Open an Firefox browser and navigate to:
	__2. In Firefox, from the Developer menu, select Responsive Web Design View of the loaded page.
	
	__3. Click the Rotate button to simulate the change of the device orientation.

	Part 3 - Make the Page Responsive to Portrait and Landscape Views
	__1. Open the /htdocs/lab/responsive_orientation.html page in your editor.
	__2. Locate and uncomment the following code fragment (remove the '/*' and '*/' comment anchors).
	__3. Save the page in your text editor.
	__4. Switch to Firefox and reload the page.
	__5. Switch back to the editor open on the responsive_orientation.html file.
	__6. Locate the following code fragment:
	__7. Swap the visibility of section1 and section2 CSS classes by cutting and pasting the display:none; rule from section2 over to section1.
	__8. Save changes.

	Part 4 - Chrome's Mobile Browser Emulator
	__1. Start Chrome browser and navigate to:
	__2. Activate the Developer Tools View.
	__3. In the Developer Tools View menu, select Settings.
	__4. Click Devices.
	__5. In the Developer Tools View menu, select More Tools → Sensors.
	__6. In the Sensors panel that gets activated, click the Emulate Device Orientation checkbox.
	__7. Enter 20 in the α input box (values are in degrees, so we entered a 20o).
	__8. Enter 45 in the β input box.
	__9. Keep Chrome browser with our page loaded open.

	Part 5 - Review the DeviceOrientation JavaScript Event
	__1. Switch to the editor window open on responsive_orientation.html.
	__2. Let's review the JavaScript code located at the bottom of the page.

	Part 6 - Lab Session Clean Up
	__1. In Chrome browser, uncheck the Emulate Device Orientation checkbox to stop this sensor simulation.
	__2. Close Chrome.
	__3. Switch to Firefox and close the Responsive Design View window.
	__4. Close Firefox.
	__5. Close the text editor.

	Part 7 - Review

	Lab 15 - Responsive Images with Media Queries
	Part 1 - Get Started
	__1. Copy these files from LabFiles to /htdocs/lab:

	Part 2 - The First Run
	__1. Open an instance of Firefox, maximize its window and navigate to:
	__2. Activate the Responsive Design View in Firefox.
	__3. Try to re-size the view by dragging the control handle at the bottom right-hand corner of the page.
	__4. Resize the Mobile View window to about 540 x 400 px (keep the Control key down for finer dragging prevision).
	__5. Keep the browser window open.

	Part 3 - Make the Image Responsive
	__1. Start your text editor and open responsive-images-via-media-query.html
	__2. Locate the <style></style> section and enter the following code between the <style> and </style> tags:
	__3. Locate the <img ...> element and add the following attribute to it:
	__4. Save the file.

	Part 4 - The Second Run
	__1. Switch to Firefox and refresh the browser window to reload our responsive-images-via-media-query.html page.
	__2. Begin minimizing the Mobile View by dragging the bottom right-hand corner handle as you did previously.
	__3. Close the browser.
	__4. Close the editor.

	Part 5 - Review

	Lab 16 - Getting Started With Bootstrap
	Part 1 - Copy Bootstrap Distribution
	__1. Copy LabFilesbootstrap directory to /htdocs/.

	Part 2 - Create the Bootstrap template HTML file
	__1. Open /htdocs/bootstrap/index.html in a text editor.
	__2. This is a simple HTML5 file. Examine the file:
	__3. First thing add the <meta> tag inside <head> tag specifying the viewport parameters. This tag will be added in the head section below the title.
	__4. Next add a link to the Bootstrap CSS file right below the <meta> tag:
	__5. Finally, add the script references to the end of the body section (before the </body> tag):
	The completed template file should look like:
	__6. Save the file.
	__7. Save a copy of the file as poetry.html. (You will use it in the next lab)
	__8. Close all editors.

	Part 3 - Add some Bootstrap content
	__1. Open index.html in a text editor.
	__2. Add the following div element after the <body> and before the first <script>:
	__3. Save the file.

	Part 4 - Test
	__1. In a browser connect to:
	__2. You should see:
	__3. Try resizing the browser window to see the responsive behavior.
	__4. Close all open files and browsers.

	Part 5 - Review

	Lab 17 - Simple Components
	Part 1 - Create the Navigation
	__1. Open /htdocs/bootstrap/poetry.html in a text editor.
	__2. Add the following div element after the <body> and before the first <script>:
	__3. Next add the following inside the <nav> elements.
	__4. Next add the following code after the </div> from the previous step.
	__5. Next add the following code after the </div> from the previous step.
	Note: the poems are in LabFilespoetry.txt. To get the full effect of the lab, copy the poems or at least enter multiple paragraphs of text in place of '...'
	__6. Save the file.

	Part 2 - Test
	__1. In a browser connect to:
	You should see:
	__2. Try resizing the browser window to see the responsible behavior.
	__3. Close all open files and browsers.

	Part 3 - Review

	Lab 18 - Integrating jQuery with Bootstrap Components
	Part 1 - Reviewing the Page with JavaScript Functions' Stubs
	__1. Open //bootstrap/Bootstrap_with_jQuery.html in a text editor.
	__2. You should see the following content:
	__3. Open a web browser and navigate to the following URL:
	__4. Leave the browser open to the page.
	__5. Switch back to the text editor.

	Part 2 - Adding jQuery Code for Component Hiding and Showing
	__1. Switch to your text editor that has the Bootstrap_with_jQuery.html open and locate the following code:
	__2. Enter the following code between the {} curly braces:
	__3. Locate the following code:
	__4. Enter the following code between the {} curly braces:
	__5. Save the file.
	__6. Switch to your web browser and refresh the page:
	__7. Click the Show the message … button and discard the "About to show the message" pop-up by clicking OK.
	__8. Click the Hide the message … button and discard the "About to hide the 'Alert!' message" pop-up by clicking OK.

	Part 3 - Adding jQuery Code for Attaching and Removing a Glyphicon
	__1. Switch to your text editor with Bootstrap_with_jQuery.html and locate the following code:
	__2. Enter the following code between the {} curly braces:
	__3. Locate the following code:
	__4. Enter the following code between the {} curly braces:
	__5. Save the file.
	__6. Switch to your web browser and refresh the page:
	__7. Click the Assign me a star rating! button.
	__8. Click the Assign him a starless rating ... button.
	__9. Close your browser.
	__10. Close your text editor.

	Part 4 - Review

	Lab 19 - Mobile Web Testing With Chrome
	Part 1 - Emulation of Mobile Browsers in Chrome
	__1. Start Chrome browser and navigate to:
	__2. Open the Developer Tools.
	__3. Click the Toogle device toolbar.
	__4. The emulator will open. Expand the list and select Edit.
	__5. Select the BlackBerry Z30 option from the device drop-down.
	__6. BlackBerry Z30 will emulate.
	__7. Click the menu and select Show rulers.
	__8. Try changing the device and orientation.
	__9. Close the Developer Tools.
	__10. Close all browsers.
	__11. Close your text editor.

	Part 2 - Review




